
InterCal Users’ Guide

Table of Contents

1. INTRODUCTION.....................................................................................................................................................1

2. STARTUP STATE....................................................................................................................................................1

3. THE MAIN WINDOW.............................................................................................................................................3

3.1. STATIC CALENDAR SYSTEM DISPLAYS ..............................................................................................................3
3.2. SPECIFYING THE DISPLAYED DATE .....................................................................................................................8

3.2.1. Typical Linear Calendar Systems ....................................................................................................................8
3.2.1.1  Month/Era Selection ....................................................................................................................................................8
3.2.1.2. Year Selection..............................................................................................................................................................9

3.2.2. Mayan Calendar Display Controls ................................................................................................................10
3.2.2.1. The Long Count .........................................................................................................................................................11
3.2.2.2. The Tzolkin Cycle, Haab Cycle, and Calendar Round.............................................................................................. 11

3.3 THE MONTH CALENDAR AND DAY SELECTION................................................................................................13
3.3.1. The Day Boxes................................................................................................................................................13
3.3.2. Date Selection ................................................................................................................................................14

4. THE MENU BAR....................................................................................................................................................15

4.1. FILE MENU ............................................................................................................................................................15
4.1.1 Quit..................................................................................................................................................................15
4.1.2 Page Setup Main… or Page Setup JDate… ....................................................................................................15
4.1.3 Print Main… or Print JDate…........................................................................................................................15

4.2. EDIT MENU............................................................................................................................................................17
4.3. PRIMARY AND SECONDARY MENUS..................................................................................................................17
4.4. THE OPTIONS MENU ............................................................................................................................................18

4.4.1. Show Date Window ........................................................................................................................................18
4.4.2. Holidays…......................................................................................................................................................20
4.4.3 Jump To Selected.............................................................................................................................................22
4.4.4 Return To Today..............................................................................................................................................22
4.4.5 Reverse Calendars...........................................................................................................................................23
4.4.6. Mayan Correlations…....................................................................................................................................23

5. LIMITATIONS .......................................................................................................................................................26

5.1. YEAR AND JULIAN DAY RANGES.......................................................................................................................26
5.2 EXCESS HOLIDAY COLLISIONS............................................................................................................................26

6. KNOWN PROBLEMS ...........................................................................................................................................27

6.1. EXCEEDING THE LONG INTEGER LIMIT ............................................................................................................27
6.2. IMPROPERLY DISPLAYED POPUPS .....................................................................................................................27



Page 1

1. INTRODUCTION

The purpose of InterCal is to permit rapid and convenient comparison of dates in
multiple calendar systems. It is thus useful for genealogical research and historical
research. InterCal can also be used as a perpetual calendar to determine the day of week
of any date, the approximate phase of the moon of any date, and the dates of various
religious holy days such as Easter, Yom Kippur, the first day of Ramadan, or Chinese
New YearÕs in any year. Researchers please noteÑwhen a calendar is supported by
InterCal, usually only the most recent version is implemented, and its rules are
extrapolated indefinitely backwards and forwards in time. Some modern calendars
have undergone rules changes in the past, so researchers need to be careful when
comparing dates calculated by InterCal to dates in historical documents. For detailed
explanations of the implemented calendar systems, and some definitions of terms (such
as era), please see the accompanying document     Calendar System Facts  .

InterCal is a simple program with (I hope) an intuitive interface. You should be
able to familiarize yourself with all the options in a few minutes simply by running the
program and playing around. (The only exceptions might be the handling of editing the
year field, and controlling the display when the Mayan is the primary calendar.)
Nevertheless, this UsersÕ Guide tries to be a complete reference which can be turned to
when a question arises.

InterCal defines two special dates, both of which can be manipulated by the user.
The displayed date controls the month calendar display which dominates the main
window. The selected date is used to serve as a marker which can be returned to at any
time using the ÒJump To SelectedÓ command under the Options menu. The Julian Date
window shows its equivalent in all implemented calendar systems. So if you want to
know what your birthday is (for example) in all implemented systems, make it the
selected date and show the Julian Date window. If the selectedDate is not visible in the
currently-displayed month, then displayedDate is the first day of the displayed month. If
selectedDate is visible, then displayed date and selected date are equal.

2. STARTUP STATE

InterCal has three windows which can be left permanently open, plus some
modal dialogs and Alerts which appear and disappear as they are needed. The main
window (described in detail in ¤3) is always visible. Both its size and position are
adjustable. The ÒdateÓ window (described in ¤4.4.1) is not visible at startup. Its visibility
is controlled by the user. Its size is not adjustable but its position is. The ÒMayan
CorrelationsÓ window (described in ¤4.4.6) is also not visible at startup. Its visibility is
controlled by the user. Both its size and position are adjustable.

The program tries to draw all windows with exactly the same size and position
which they had the last time the program was run. If that cannot be done for any
reason, the program reverts to its defaults. The default for the main window is near the
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upper left corner of the main screen, with a size which nearly fills it. However, a
maximum size is built in so that the window will never exceed the size necessary to
display all of its contents at once. The defaults for the date window and the Mayan
Correlations window are to be centered on the main screen.

The program starts up with the Primary and Secondary calendar settings the
same as they were the last time the program was run. The first time it is run after
downloading, the initial primary calendar system is Western Historical and the initial
secondary calendar system (see below for definition of a secondary calendar) is ÒnoneÓ.
The year and month are chosen so that todayÕs date is visible and selected. Since it is
selected, it is highlighted using reverse video.

A variety of Christian, Jewish, and Islamic holidays can be highlighted under
user control. The program attempts to use the same settings which were in effect the
last time the program was executed. If it cannot do so, it reverts to the defaults. The
default is to highlight the following religious holidays/holy days: Western Easter,
Julian Easter (same as Orthodox Easter), Christmas (Western), Rosh Hashonah, Yom
Kippur, first day of Hanukah, Passover, first day of Ramadan, Islamic New Year, Milad-
an-Nabi (birthday of the Prophet), and the first day of ÔId al-Fitr (festival after Ramadan
is over). (It may seem strange to most people to highlight Christmas, since it is a fixed
feast. But it is only fixed in the Gregorian calendar and its relatives! All Jewish and
Islamic holy days are fixed in their respective calendars. Easter and Pentecost are the
only truly movable feasts handled by InterCal.) If the current screen is operating in
color mode, Christian holidays are shown in yellow, Jewish in blue, and Islamic in red. I
chose these colors from among the basic eight colors provided in the very first version
of QuickDraw. If the current screen is monochrome, holidays are highlighted using
three of the standard patterns found in the system resource file.

The Mayan correlation last specified by the user and the values of the Mayan
controls (described in detail later in this document) are remembered from the last time
the program was run. As released, InterCal uses the (unmodified) Goodman-Martinez-
Thompson correlation, which has Long Count 0.0.0.0.0 corresponding to Julian Day
584283 (September 6, 3114 B.C. Julian = August 11, 3114 B.C. Gregorian). ÒMove to
futureÓ is on. ÒEdit together as Calendar RoundÓ is not checked.

3. THE MAIN WINDOW

3.1. Static Calendar System Displays

The main window is divided into several panes: the primary and secondary
calendar system labels; controls for specifying the displayed date; and the month
calendar.
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Here is a sample showing a typical linear calendar as the primary:



Page 4

Primary Calendar Seconda

1997

Sunday Monday Tuesday Wednesday

Western Historical

    1111
 3 Anne

1914 AZ

    2222
 4 Anne

1914 AZ

    3333
 5 Anne

1914 AZ

    7777
 9 Anne

1914 AZ

    8888
10 Anne
1914 AZ

    9999
11 Anne
1914 AZ

11110000
12 Anne
1914 AZ

11114444
16 Anne
1914 AZ

11115555
17 Anne
1914 AZ

11116666
18 Anne
1914 AZ

11117777
19 Anne
1914 AZ

22221111
23 Anne
1914 AZ

22222222
24 Anne
1914 AZ

22223333
25 Anne
1914 AZ

Hanukah

22224444
26 Anne
1914 AZ

22228888
30 Anne
1914 AZ

22229999
 1 Colette
1914 AZ

33330000
 2 Colette
1914 AZ

1 Ramadan

33331111
 3 Colette
1914 AZ

Month: December

InterCal
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Secondary Calendar

1997

nesday Thursday Friday Saturday

Elliott Super

    3333
 5 Anne

1914 AZ

    4444
 6 Anne

1914 AZ

    5555
 7 Anne

1914 AZ

    6666
 8 Anne

1914 AZ

11110000
12 Anne
1914 AZ

11111111
13 Anne
1914 AZ

11112222
14 Anne
1914 AZ

11113333
15 Anne
1914 AZ

11117777
19 Anne
1914 AZ

11118888
20 Anne
1914 AZ

11119999
21 Anne
1914 AZ

22220000
22 Anne
1914 AZ

ah

22224444
26 Anne
1914 AZ

Christmas

22225555
27 Anne
1914 AZ

22226666
28 Anne
1914 AZ

22227777
29 Anne
1914 AZ

adan

33331111
 3 Colette
1914 AZ

Era: A.D.

InterCal
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Here is a sample showing the Mayan calendar as primary:

Primary Calendar Seconda

Sunday Monday Tuesday Wednesday

Mayan

Hanukah

    000012.19.4.14.2
12 Ik'

26 Anne
1914 AZ

    444412.19.4.14.6
3 Kimi

30 Anne
1914 AZ

    555512.19.4.14.7
4 Manik'

 1 Colette
1914 AZ

    666612.19.4.14.8
5 Lamat

 2 Colette
1914 AZ

1 Ramadan

    777712.19.4.14.9
6 Muluk

 3 Colette
1914 AZ

1111111112.19.4.14.13
10 Ben

 7 Colette
1914 AZ

1111222212.19.4.14.14
11 Ix

 8 Colette
1914 AZ

Epiphany

1111333312.19.4.14.15
12 Men

 9 Colette
1914 AZ

1111444412.19.4.14.16
13 Kib

10 Colette
1914 AZ

1111888812.19.4.15.0
4 Ahaw

14 Colette
1914 AZ

1111999912.19.4.15.1
5 Imix

15 Colette
1914 AZ

Long Count
0.0.0.12.19.4.14.19

Tzolkin:

Haab:

InterCal
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Secondary Calendar

Wednesday Thursday Friday Saturday

Elliott Super

Hanukah

    00002.19.4.14.2
2 Ik'

26 Anne
1914 AZ

Christmas

    111112.19.4.14.3
13 Ak'bal

27 Anne
1914 AZ

    222212.19.4.14.4
1 K'an

28 Anne
1914 AZ

    333312.19.4.14.5
2 Chikchan

29 Anne
1914 AZ

 Ramadan

    77772.19.4.14.9
Muluk

 3 Colette
1914 AZ

    888812.19.4.14.10
7 Ok

 4 Colette
1914 AZ

    999912.19.4.14.11
8 Chuwen

 5 Colette
1914 AZ

1111000012.19.4.14.12
9 Eb

 6 Colette
1914 AZ

111144442.19.4.14.16
3 Kib

10 Colette
1914 AZ

1111555512.19.4.14.17
1 Kaban

11 Colette
1914 AZ

1111666612.19.4.14.18
2 Etz'nab

12 Colette
1914 AZ

1111777712.19.4.14.19
3 Kawak

13 Colette
1914 AZ

3Tzolkin: Kawak

Haab: K'ank'in 17 Calendar Round
Edit together as

Move to future

Move to past

InterCal
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On the top line at the left, in a static (not editable) text area, the current choice of
primary calendar system is displayed. To its right the current choice of secondary
system is shown. Most of the rest of the window contents refer to dates in the primary
calendar system. The secondary system (if there is one) is used to directly compare
dates in one system to the same dates in the other system. See ¤4.3, ÒPrimary and
Secondary MenusÓ, for more details.

3.2. Specifying the Displayed Date

Controls for manipulating the displayed date occupy the next few lines in the main
window. Two types of calendars, with basically different structures, are implemented
by InterCal. Their method of controlling the displayed date differs accordingly. Most
calendars are linear (as explained in     Calendar System Facts  ). Such calendars have years
and (usually) eras. Dates follow a linear progression. All calendars implemented by
InterCal except the Mayan and Chinese fall into this category. The Mayan is a cyclic
calendar and is also really three calendars in one. The controls for determining the
displayed date in the Mayan calendar look and act completely differently from those for
all other implemented calendars. The Chinese, although actually cyclic, is treated as
linear by InterCal by counting the cycles and including a cycle number in the year
designation. The net result is that the Chinese calendar looks and acts like all the linear
calendars except that there are no eras (negative cycle numbers are used instead) and
the year box contains two integers instead of one. More details are given in the ÒYear
selectionÓ section below.

3.2.1. Typical Linear Calendar Systems

The month, era, and year selection controls appear near the top of the main
window whenever a linear calendar is the primary system.

3.2.1.1 Month/Era Selection

The first line in the control area is in larger type. At the left is the name of the
month being displayed. At the right is the era of the displayed month. Both the name of
the month and the name of the era are actually entries in popup menus. The user can
use the menus to switch to a different month in the same year, or to switch eras while
keeping the month and the absolute value of the year the same. (Switching eras is not
applicable when the Chinese calendar is Primary. In that case the era popup menu is
replaced by three non-editable text lines which show the double names of the year,
month, and day of the displayedDate. See ÒCalendar System FactsÓ for more information
on these names.) These menus are written using the Avant Garde font, which I believe
is available on most Macintosh systems.
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Immediately to the left and right of the month name/menu are large arrows.
They are blue or dark gray depending on your monitorÕs color mode. These arrows act
like buttons. They can be clicked once, or pressed (click and hold down the mouse). The
left-pointing arrow decreases the month, while the right-pointing arrow increases the
month. When the mouse is released, the rest of the window is redrawn to match the
newly-selected month. It is OK to press so long that the months cycle past a year
boundary. The program works correctly even if the era happens to change while
pressing a month-changing button.

Thus there are two alternate ways to change months. The pop up menu might be
most convenient for jumping from one end of a year to the other, whereas the arrow
buttons might be best for moving a few months at a time.

3.2.1.2. Year Selection

Centered in the next line down, in medium type, is a box displaying the absolute
value of the year. To determine the sign of the year, you need to look at the era display.
(In the Chinese calendar, two numbers appearÑcycle and year-within-cycle. There is no
era display but the cycle may be negative but not zero.) The year box is surrounded by
two arrow buttons. These buttons act similarly to the month buttons described above,
except that they decrement or increment the year. The down-pointing arrow at the left
decreases the actual value (not the absolute value) of the year. Thus it takes you
towards the past. The up-pointing arrow at the right increases the actual value of the
year, taking you towards the future.

The arrow buttons are only useful for moving a few years at a time. In order to
enable large jumps in time, the year displayed in the box is an editable text field. The
idiosyncrasies of editing the text field which specifies the year may be confusing. That is
the primary reason I felt it was worth writing this UsersÕ Guide.

In the year box, you can select text or place the insertion cursor wherever you
want, and then follow normal text editing conventions to adjust the year to almost any
value you desire. While you are doing this, the edit menu becomes active, permitting
one-step undo/redo, cutting and pasting, and deletion of characters. You signal
InterCal that you are finished editing the year by hitting either the Return or the Enter
or the Tab key. If you change your mind while editing, the Escape key or Cmd-period
ends your editing session and restores the year to the value it had before you started
editing.

(Chinese) Note that when the Chinese calendar is primary, the editable field
consists of two numbersÑnot one as usual. The first is the cycle; the second is the year
within the cycle. As explained in ÒCalendar System FactsÓ, the nature of the calculations
forces the range of allowable years in the Chinese calendar to be restricted to about 6000
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years on either side of the present. This translates to a valid range for the cycle between
-23 and 178 inclusive. The cycle may not be zero. The year within the cycle must always
be in the range 1 to 60 inclusive.

Editing the year normally leaves the month unaffected. However, luni-solar
calendars have years with differing numbers of months and this may force a change of
month. For example, if you are in the Jewish calendar displaying Adar I 5755 A.M. and
jump to a non-leap-year, such as 5754 A.M., the month will change to Adar. Similarly,
jumping from a leap year in the Elliott calendar, while displaying the month of
Anthony, to a non-leap-year causes the month to switch to Ericka. It doesnÕt matter
whether the arrow buttons or the editable text field are used to change yearsÑthe
same rule applies.

I wanted the user to be able to jump immediately from any year to any other year
(within limits specified below) in a single editing step. This led me to a slight problemÑ
namely, the fact that (in keeping with good calendrical conventions) the box is
displaying the absolute value of the year (except of course for the Chinese calendar).
What if the user wants to jump to a year in the other era? What if he/she doesnÕt? Of
course you could always do the job in two steps, using the era popup and editing the
year text box. But that would be inconvenient. I eventually settled on the following
rules applicable to all linear calendars (but not the Chinese):

a) If the user simply manipulates the numbers in the year without providing an
explicit sign (plus or minus), the era remains the same. As an example, if you
are in April 4956 B.C. and edit the year box to read Ò111193Ó, you will be taken
to April 111193 B.C.

b) If the user explicitly enters a sign immediately before the year (no spaces
permitted) the era is forced to agree with the entered sign (which will then
disappear from the display). For example, if you are displaying April 4956 B.C.
and edit the year to read Ò+111193Ó you will be taken to 111193 A.D. In either
case [a] or [b], the final year display will read simply Ò111193Ó, but the era
display in the two cases will be different, as will (usually) the month calendar
itself.

For the Chinese calendar, explicit signs are allowed on the cycle number and signs
remain in the year box. There is no era menu. Numbers entered without a sign are
always treated as positive.

3.2.2. Mayan Calendar Display Controls

The Mayan controls appear whenever the Mayan is the primary system. They
show the displayed date in each of the three different Mayan CalendarsÑthe Long Count,
the Tzolkin cycle, and the Haab cycle. Any of the three can be manipulated to change
the displayed date as described below. Once one has been changed, the program updates
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the entire display so that the dates in all three Mayan calendars (and the month
calendar display) agree.

I recommend playing with the Mayan controls before reading this section of the
guide. I hope they are intuitively grasped and will be much easier to handle than the
following lengthy (but complete) text may make it seem.

3.2.2.1. The Long Count

The Long Count is displayed in large type at the left of the controls pane. It
always contains the full 8 vigesimal digits (see     Calendar System Facts   for detailsÑ
InterCal uses 8 digits, not the usual five, to cover long time spans). Each digit is
separated from the others by a period. The Long Count is an editable text field which
behaves much like the year field described in ¤3.2.1.2 above. The same keys are used to
terminate editing and the same editing capabilities are available. If the format of the
Long Count is not acceptable when you press Return, Enter, or Tab  an alert appears
and the old value of the Long Count is restored. If the format is acceptable, the main
window display is updated immediately.

The rules for a valid Long Count are:
1) A sign may optionally precede the first digit. If no sign is present the Long

Count is presumed to be non-negative.
2) There must be exactly 8 vigesimal digits separated by exactly seven periods.

Leading zeroes, if applicable, are required.
3) Each digit must be in the range 0Ð19 inclusive, except the second digit from the

right is restricted to 0Ð17 inclusive.
4) If the Long Count value is too large another alert will appear. Dates much

above 1.17.5.0.0.0.0.0 would cause overflow and lead to garbage results in the
calculations.

5) Except for the separating periods and the optional sign before the first digit,
non-numeric characters are forbidden.

Note that changing the displayed date in this way has no effect whatsoever on the selected
date.

3.2.2.2. The Tzolkin Cycle, Haab Cycle, and Calendar Round

The Tzolkin date and the Haab date are both displayed at the right of the Long
Count. At the extreme right of the pane are two radio buttons and a check box.
Remember that both the Tzolkin and Haab calendars are cyclic, with no year associated
with them. InterCal assumes that when you change a Tzolkin or Haab date you want to
go to the next Julian Day having the specified Tzolkin or Haab date. The radio buttons,
which can be reset at any time, control whether you go to the next date in the past or
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the next in the future. The check box determines whether you wish to edit the Tzolkin
date or the Haab date in isolation (when the box is unchecked) or together as a
Calendar Round date.

The Tzolkin day name is actually a pop up menu which can be used to modify
the Tzolkin date. The Tzolkin day number is an editable text field which permits only
unsigned integers in the range 1Ð13 inclusive. The usual rules for terminating the
editing of the text field apply.

The Haab month name is also a pop up menu, used for changing the Haab
month. The Haab day is another editable text box, which accepts only unsigned integers
in the range 0Ð19 inclusive (0Ð4 if the ÒmonthÓ is Wayeb).

Note that, unlike in linear calendars, you have control down to the day (not just
month) of displayed date. If the Haab displayed date is, for example, 6 Mol, and you
change the Haab day from 6 to 7, what happens depends critically on the setting of the
past and future radio buttons. If ÒMove to futureÓ is selected, changing from 6 to 7 has
only a slight effect on the main window display. The Haab day text field will change,
the Long Count will increment by 1, and the Tzolkin day number and name will
increment by one each. But the big month display which fills most of the window will
not change. But if ÒMove to pastÓ is on, changing from 6 to 7 moves you 364 days into
the past. The change is especially noticeable if you have a secondary calendar in force.
Similarly, accepting a ÒchangeÓ of the Haab or Tzolkin date of zero (no change)
transports you one full cycle into the past or future.

 Since both Tzolkin and Haab are cycles, it often is not intended to change just
one part of a date. For that reason, starting to edit either the Haab or Tzolkin date places
the program into a special mode which treats the Tzolkin and Haab controls like a
modal dialog. The Long Count and the ÒCalendar RoundÓ check box are deactivated
and will not accept changes. The month display (described later) will not accept clicks.
If the date window and/or the Mayan Correlations window (described later) happen to
be visible, they temporarily disappear. If the ÒCalendar RoundÓ check box is not
checked, either the Tzolkin or the Haab controls are also deactivated (whichever was
not modified). Two buttons appear at the immediate left of the Haab controls. One is
labeled OK and the other is Cancel. You can continue to change whichever of the Haab
and Tzolkin controls are still active while the rest of the display remains frozen.
Clicking on OK accepts the changes, updates the entire display, re-shows the date and
correlations windows if applicable, and puts the program back into its normal mode.
Clicking Cancel restores the Tzolkin and/or Haab dates to what they were before you
started modifying them, and then acts the same way as OK.

Note that it is not possible to make large jumps in time using the Haab/Tzolkin
controls. You are limited to jumps of 365 days, 260 days, or (if the Calendar Round
check box is checked) about 52 years. Large jumps can be made using the Long Count
field or by going into the date window, modifying the selected date, and then using the



Page 13

Jump To Selected menu command. (These latter methods are described in detail later
in this UsersÕ Guide.)

If the Calendar Round check box was unchecked when you started editing, any
change to the Haab or Tzolkin date is acceptable. Whichever you did not edit will be
updated by the program to agree with the new choice. If the Calendar Round check box
was checked, it is quite possible you will specify an impossible Haab-Tzolkin
combination. In this case a modal dialog window appears and offers you several
choices. You can Try Again. Pressing that button merely resumes your Calendar Round
editing session where you left off. Or you can pick one of six buttons labeled with
choices which are guaranteed to result in a valid combination. There are two Haab
buttons and four Tzolkin buttons. The two Haab buttons surround the Haab date you
specified and are compatible with the Tzolkin date you specified. The four Tzolkin
buttons are similar in some way to the Tzolkin you specified, and are compatible with
the Haab you specified. (By ÒsimilarÓ is meant: either the day name has changed by the
minimum necessary while keeping the day number as you specified; or both the day
name and number have changed simultaneously by the minimum amount required for
compatibility with the Haab you specified. Note that changing a Tzolkin day number
without also changing the day name cannot produce a compatible Tzolkin date.)

3.3 The Month Calendar and Day Selection

3.3.1. The Day Boxes

Most of the main window is taken up by a calendar showing the month selected
by the user using the methods described above. For the Mayan calendar, the Haab
month is displayed. Each box in the calendar is either blank or has the day of the
month in large bold type in the upper right. If a secondary calendar system has been
chosen, there are two lines (small type, right-justified in the box) below the day number
showing the date in the secondary system. The first of the two small lines shows the day
and month (linear calendars) or the Long Count (Mayan). The second shows the year
and era( linear), cycle and year (Chinese), or the Calendar Round date (Mayan). As
explained in     Calendar System   Facts, the Chinese calendar has a more limited range of
use than other calendars. It is limited to a period from about 6000 years ago to about
6000 years from now.  If the secondary system is Chinese and the displayedDate is
outside the legal range for a Chinese date in InterCal, a series of asterisks is displayed in
place of the Chinese date. This is not an error situation.

If the Mayan calendar is the primary system, two or three small lines in the
upper left of the box show the Long Count and the Tzolkin date for each day. Whenever
the Long Count is shown within a day box, whether the Mayan calendar is the primary
or secondary system, any leading zeroes are not displayed (to eliminate clutter from the
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crowded display). When the Mayan calendar is primary, the 8 Long Count digits are
shown separately. The first three (which are unique to InterCal) are shown on the top
line in the upper left of each day box. The next five digits appear on the second line. If
the Long Count is non-negative and if the first three digits are all zero (which will
usually be the case) the top line is not displayed.

If the Mayan calendar is not the primary system, and if the Chinese calendar is
either Primary or Secondary, three small lines in the upper left of the appropriate boxes
show the solar terms in both Chinese and English. (Solar terms are defined in ÒCalendar
System FactsÓ.) Major terms are in normal style; minor terms are in italics. Usually there
will be one major and one minor solar term in a month. Sometimes there will be just one
solar term and sometimes three.

If the displayed month contains a holiday which the user has designated for
highlighting (see ¤4.4.2 below) the name of the holiday appears on the next line (left
justified). It is possible for holidays to collide (for example, Christmas and Hanukah). In
such cases more than one name appears in the box. In case of collision, the highlight
colors or patterns appear with the following priority: Christian overrides Jewish which
overrides Islamic. This ordering merely reflects the order of checking for holidays in the
code. Please do not read any ulterior motives into the orderingÑthere are none.

If the displayed month includes the selected date (see next subsection) or todayÕs
date, they are also highlightedÑalways in black and white. The selected date appears in
reverse video. TodayÕs date appears with a light-gray background. On the screen,
selection overrides all other highlightingÑthe selected date always appears in reverse
video whether or not it is todayÕs date or a highlighted holiday. The ÒtodayÕs dateÓ
highlighting overrides holiday highlighting, but not selection. When printing, slightly
different rules apply, as explained in detail in ¤4.1.3 below.

3.3.2. Date Selection

The user may select any displayed date by clicking once in its box. He/she may
cause there to be no selected date by clicking on any blank box in the month calendar.

Selecting a date serves two functions. The user may want to mark a date to
return to later after exploring other months or years (see ¤4.4.3). Or you may want to
see at a glance that dateÕs equivalent in all implemented calendars using the date
window (see ¤4.4.1). Causing there to be no selected date serves no apparent function
unless the user finds the reverse video box to be aesthetically unappealing, but I had to
decide to either ignore clicks in blank boxes or do something. I chose the latter.

Selecting a date by clicking in a box on the month calendar has the side effect of
changing displayedDate to equal the newly chosen selectedDate. This was done to simplify
the task of switching primary calendars without losing the selected date from the
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display. If the Mayan calendar is the primary system, you will see the Mayan controls
change values. If the Chinese calendar is primary, the name of the day (in the upper
right part of the month display where the era menu normally resides) will change to
reflect the new displayedDate. There is another way to select a date which does not
require the date to be in the current month calendar display. It is described in ¤4.4.1
below.

4. THE MENU BAR

4.1. File Menu

Three commands on the File menu are always activeÑ Quit, Page SetupÉ, and
PrintÉ. The Close command is active when either the Julian Date window or the
Mayan Correlations window is in front (active). Other commands are visible but
inactive. They are there for desk accessories.

4.1.1 Quit

The Quit command saves window size and position information, holiday
selections, Mayan correlation choice (see ¤ 4.4.6 below), Primary and Secondary
calendar system choices, and print records, then quits the program.

4.1.2 Page Setup Main… or Page Setup JDate…

This command brings up the standard Page Setup dialog for the print manager.
InterCal uses and stores two print records, one for each window. (This is done because
the main window is best printed in landscape mode, while the date window is best
printed in portrait mode.) The name of this command changes depending on which
window is active, to remind you of which record you are affecting.  If the date window
is active, the command reads Page Setup JDateÉ, otherwise it reads Page Setup
MainÉ. After your initial setting up, it is unlikely you will ever need this command
unless you switch printers.

4.1.3 Print Main… or Print JDate…

The PrintÉ commandÕs name on the menu is changed to either Print Main É or
Print JDateÉ, depending on whether the date window is active. The Print MainÉ
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command brings up a print dialog which has an added choice. A check box is available
which is explained below. What you see on the screen depends on your print driver.
Older versions on LaserWriter append the check box to the bottom of the Print dialog
box. The Adobeª print driver does the same thing. But newer versions of LaserWriter
have a PopUp menu which says ÒGeneralÓ. Pop the menu and you will see an option
ÒInterCalÓ. If you select that option the check box will appear. I do not know what the
ImageWriter driver does.

The main window must be printed in landscape mode in order to fit on one 8.5
by 11 page. Depending on your printer and driver, you may also need to scale the print
(using the Page Setup command) to 90% or 95% of full size. The Print JDateÉ
command brings up the standard print dialog to print the date window.

The added check box, ÒColor PrinterÓ, appears when you select Print MainÉ.
(The date window has no color in it, and so InterCal doesnÕt care whether or not you
have a color printer when printing the date window.) Remember that holidays are
highlighted in color on a color monitor and using fill patterns on a monochrome
monitor. InterCal does the same thing for printers. The problem is that there appears to
be no way for an executing program to know whether or not the chosen printer has
color capability and is operating in color mode. InterCal relies on the user to specify this
information. (Executing programs can detect whether or not the printer driver is color-
QuickDraw-aware. If it is not, then the printer must be black-and-white or at least
operating in black-and-white mode. But if it is, the printer might still be black-and-
white.)

InterCal stores the userÕs choices for this check box, and always presents the most
recent choice as the default. If you have chosen a different printer between print
requests, this may not be appropriate.

The following differences exist between what you see on the screen and what is
printed:

1) There is no inversion (equivalent to reverse video on the screen) on many
printers, so the rules for highlighting are changed for printing. Instead of
having the highest priority (as it does on the screen), selection has the lowest
priority. Therefore, the selected date will appear in black and white reverse
video on the printout only if it is not todayÕs date, not a highlighted holiday,
and only if your printer supports inversion.

2) The month and year incrementing/decrementing arrows are not printed for
linear calendars, and the radio buttons and check boxes at the right side of the
Mayan controls do not print. I have been unable to figure out how to make
them print.
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4.2. Edit Menu

The Edit menu is normally inactive. It is provided primarily for desk accessories.
However, it automatically becomes active when the user edits any of the editable text
fields such as the Julian Day in the Date Window. At that time, the standard edit
commands are activated.

4.3. Primary and Secondary Menus

The next two menus are labeled Primary and Secondary. These menus are used
to set the calendar systems to be displayed in the main window. The options available
in both menus are the implemented calendars, plus a choice of None for the secondary
system.

You can change the primary system at any time. The presently-selected primary
system is deactivated in the menu, but all other choices are available. If you select as the
new primary system a calendar which is currently the secondary one, the program
obeys your command and automatically resets the secondary system to ÒNoneÓ.

When you change primary systems, the entire main window is redrawn with
displayed date controls updated to reflect the displayed date in the new primary system. Of
course, displayed date will be present somewhere in the new month display. Thus
switching primary systems will not transfer you very far in time. Since selected date and
displayed date are equal if selected date was visible in the month display before switching,
selected date would still be visible after the switch.

The secondary calendar system can also be changed at any time. If there is a
secondary system active, each day of the displayed month has its corresponding date in
the secondary system written in its box. This feature enables direct comparison of
dates in two separate calendar systems, and is one of the primary features for which
InterCal was written.

Just as any implemented system can be the primary system, any other system
can be the secondary system. The program prevents you (by disabling menu choices)
from selecting the current primary system or the current secondary system as the new
secondary system. [However, see Reverse Calendars under the Options menu (¤4.4.5)].

If the primary system is not Chinese, the choice of Chinese on the Primary menu
(normally available) is grayed out if displayedDate lies outside the range of legal Chinese
dates in InterCal. Similarly, the ReverseCalendars and JumpToSelected options (see
section 4.4 below) are disabled if their selection would result in making the Chinese
calendar the primary system while dates outside the legal range are being displayed.
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Switching secondary systems does not alter most of the main window. Only the
Òfine printÓ in each dayÕs box changes. The user has complete freedom to pick any
displayedDate even when the Chinese is the secondary calendar. As mentioned
previously, if it is out of the valid range for the Chinese calendar, asterisks appear in
place of the Chinese date.

4.4. The Options Menu

4.4.1. Show Date Window

This menu option is enabled whenever the date window is not visible, either
because it is not open or because it is completely hidden behind another window. This
window has an editable text field showing the Julian Day of selected date. So the user can
change the selected date to any value which does not trigger the text verification code.
(That code is designed to prevent entering such a large value that arithmetic overflow
would occur and invalidate all calculations.) It does not matter whether or not selected
date is presently being displayed in the main window. While editing the Julian Day
field, the Escape, Return, Tab, and Enter keys work exactly as in the year text box in the
main window.

Below the Julian Day is a table showing the selected date in all implemented
calendar systems.
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Selected Date

Julian Day Number at Midnight = 2449989.5

Western Historical   29 September                1995 AD

Gregorian            29 September                1995 AD

Julian               16 September                1995 AD

Jewish                5 Tishrei                  5756 AM

Islamic               4 Jumada’ al-Ula           1416 AH

Mayan Long Count                       0.0.0.12.19.2.9.5

Mayan Calendar Round                 1 Chikchan 13 Ch'en

Elliott Super         6 Gerard                   1912 AZ

French Revolutionary  7 Vendémiaire               204 RC

JulianDay
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Editing the Julian Day field sets or resets the selected date to whatever number
you enter. Your entry can be positive, negative, or zero. Here the usual mathematical
convention is followedÑnumbers without an explicit sign are considered to be positive.
The new selected date takes effect immediately, and the main window highlighting is
updated (if necessary) even though that window is in the background. However, there
is no automatic jumping to the new selected date. You still need to use the Jump to
Selected menu item for that.

The number you enter for the Julian Day does not have to end in .5 (which
corresponds to midnight on the prime meridian). If it does not, the program
automatically adjusts your entry to the preceding midnight.

Setting the state of the program such that there is no selected date (by clicking on
a blank box in the main windowÕs month calendar pane) has no effect on the date
window. Thus it is more accurate to say that the date window shows the most recently
selected date. I thought about ensuring that the date window is closed when there is no
selected date, and also of disabling the Show Date Window option in the Options
menu. That seemed to me to be the most rational approach. But reading the Macintosh
user interface guidelines made me think that such an arrangement violates the
guidelines. User feedback on this subject is welcome.

When active, the date window can be closed by clicking on its close box or by
using the Close command on the File menu. If it is entirely surrounded by the main
window, it can be hidden by activating the main window.

4.4.2. Holidays…

The Holidays option brings up a modal dialog box which lets the user determine
which of the implemented holidays should be highlighted. (The highlighting scheme
was described earlier.) The dialog box contains three columns (one each for Christian,
Jewish, and Islamic). Within each column there are three radio buttons and a group of
check boxes. If the ÒAll Ó button is on, every implemented holiday for that religion will
be highlighted. If the ÒNoneÓ button is on, none of them will be highlighted. If the
ÒCheckedÓ button is on, the check box group is active and individual holidays may be
selected or deselected for highlighting. Unless the ÒCheckedÉÓ button is on, the check
boxes are deactivated and their settings are ignored by the program. Their values are
not updated by clicking on any radio button. This behavior differs noticeably from the
behavior of the check boxes in InterCal Versions 1.0 and 1.1. Clicking on OK accepts
the new settings. Cancel closes the box without updating the old set of selections.
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Choose holidays/holydays to display

None None None

Christmas

Wstrn Pentecost

Rosh Hashonah

Yom Kippur

Purim

Pesach

Hanukah

1 RamadanWestern Easter

OK Cancel

Shavuot

Sukkot

Epiphany

 Milad-an-Nabi

 New Year

 Lailatul MiÔraj

 Lailatul BaraÕat

 ÔId al-Fitr

 ÔId al-Adha

Julian Easter

Julian Pentecost

All

Checked

All

Checked

All

Checked

Christian Jewish Islamic
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Regardless of the userÕs settings, holidays are not highlighted in the following
cases:

1) Christian holidays/holy days in the B.C. era;
2) Jewish holidays/holy days in the B.W. era;
3) Islamic holidays/holy days in the B.H. era.

Some holidays/festivals/observances last for several days or, in the case of
Ramadan, an entire month. In such cases, only the first day is highlighted.

The dates of Christmas and Epiphany are calculated in the Western Historical
calendar. That is, the Julian calendar dates and rules are used on or before October 4,
1582 A.D. and the Gregorian calendar dates and rules are used after that date. Thus, if
your primary calendar is Gregorian in years before 1582, or the Julian in years after
1582, do not be surprised to see Christmas or Epiphany seeming to fall on dates other
than December 25 and January 6. I did not bother to have separate Julian and Gregorian
choices for these holidays, since they are fixed. Christmas is December 25 and Epiphany
is January 6 (Julian in Orthodox Christian churches; Gregorian otherwise). So, in years
after 1582, it is not possible to have Julian Christmas or Epiphany highlighted, but (by
setting the secondary calendar system to ÒJulianÓ) it is still easy to determine when they
occur.

I do have separate boxes for Julian and Western Easter and Pentecost. ÒWesternÓ
Easter (used by the Roman Catholic and most Protestant churches) uses the old Julian
rules for years 1582 and earlier, and the revised Gregorian rules for years 1583 and later.
Eastern Orthodox churches are still using the Julian Calendar to determine the dates of
all holidays. So ÒJulianÓ Easter permits you to see when the Orthodox churches will
celebrate Easter, no matter what the year (and similarly for ÒJulianÓ Pentecost). You will
probably also want to use Julian Easter for determining the holiday dates in Protestant
countries during the years after 1582 but before your country of interest switched to the
Gregorian calendar. In years 1582 and earlier, the holidays always collide, so InterCal
simply uses one holiday labelÑÓEasterÓ or ÒPentecostÓ as appropriate.

4.4.3 Jump To Selected

Selecting Jump To Selected causes displayed date to be reset (if necessary) to
selected date. If there is no selected date, this menu item is disabled.

4.4.4 Return To Today

Selecting Return To Today causes displayed date to be reset (if necessary) to
todayÕs date.
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4.4.5 Reverse Calendars

Selecting Reverse Calendars switches the roles of the primary and secondary
systems. The former primary system becomes the secondary, and vice versa. This item
is disabled if there is no secondary system active. Since the months rarely overlap
exactly, there have to be some rules for determining which month in the new primary
system is displayed. The same rules are used as when a new primary system is chosen
under the Primary menu (see ¤4.3).

4.4.6. Mayan Correlations…

Selecting Mayan CorrelationsÉ brings up the Mayan correlations window. This
is a non-modal dialog which permits the user to select a correlation from among a
number of published suggested correlations, or to specify his/her own. (A correlation is
a correspondence between Long Count 0.0.0.0.0 and a particular Julian Day.) The dialog
box contains a set of radio buttons. Text describes each correlation (name of
archaeologist who suggested it; Julian Day number of 0.0.0.0.0, Julian calendar date of
0.0.0.0.0, and Gregorian calendar date of 0.0.0.0.0.) The uppermost radio button, if
selected, activates an editable text box in which the user can enter any Julian Day
number desired. All Mayan dates active in the program are updated immediately upon
the clicking of any radio button, or upon completion of editing of the user-choice field.
Note that the Julian day number of the dates is not changedÑonly the derived Long
Count, Tzolkin, and Haab dates.

This command is disabled if any part of the window is visible on the desktop,
since the window can then be activated simply by clicking on it. The window may be
closed when it is active by clicking on its close box or by using the Close command on
the File menu. If it is completely surrounded by the main window and/or the date
window, it may be hidden by activating the main window. The window may be re-
sized and repositioned.
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Select a correlation, o

Pick my own 584285

Goodman-Martinez-Thompson

(modified)
Goodman-Martinez-Thompson

Smiley

Makemson

Spinden

Thompson

Kreichgauer

Hochleitner

Escalona Ramos

Weitzel

Julian Day

584283

584285

482699

489138

489384

584281

626927

674268

679108

774078

Mayan Correlations
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or specify your own:

Julian Calendar Gregorian Calendar

September 6, 3114 B.C.

September 8, 3114 B.C.

July 23, 3392 B.C.

March 10, 3374 B.C.

November 11, 3374 B.C.

September 4, 3114 B.C.

June 7, 2997 B.C.

January 17, 2867 B.C.

April 19, 2854 B.C.

April 24, 2594 B.C.

August 11, 3114 B.C.

August 13, 3114 B.C.

June 26, 3392 B.C.

February 11, 3374 B.C.

October 15, 3374 B.C.

August 9, 3114 B.C.

May 14, 2997 B.C.

December 25, 2868 B.C.

March 27, 2854 B.C.

April 3, 2594 B.C.

Mayan Correlations
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5. LIMITATIONS

5.1. Year and Julian Day Ranges

In order to be accurate, the calendar calculations must be performed using
integer arithmetic. Since the basic unit is the day, InterCal is limited to dates for which
the integer part of the Julian Day can fit into a signed 32-bit integer. Validity checking is
performed on the Julian Day box in the Date Window, the year box in the main
window, and various other editable text fields, to try to prevent such dates from
occurring. I tried to set the limits a little narrower than actually required. However, the
logic is complex in places and the limits on Julian Day numbers and years are not
perfectly consistent. Also, it is possible (through use of the arrow buttons on months
and years) to defeat the text validation code. If any of these things happens, InterCal
should not crash, but will produce some garbage results or may put up an alert box
when you donÕt expect it. The validation code tries not allow the absolute value of
Julian Day entries to exceed 2,145,000,000 or the absolute value of year entries to exceed
5,800,000.

Chinese dates are limited to cycles -23 to +178 (with 0 being an invalid cycle).

(irrelevant note) By pure coincidence, the allowable range of years is similar to,
but a little larger than, the repetition period of Easter dates. The Easter cycle in the
Gregorian rule is exactly 5,700,000 years long.

5.2 Excess Holiday Collisions

On very rare occasions, three holidays (one Christian, one Jewish, one Islamic) all
occur on the same day. It is even theoretically possible for four to collide (both Easters
plus a Jewish and an Islamic holiday), although I do not know if such a thing actually
happens. Since screen space is limited, since I did not want to induce eye strain in the
user, and since triple (or greater) collisions are so rare, I decided not to adjust box sizes
or fonts to ensure that the names of all holidays would fit into the same box. Instead,
when this happens, holiday names overflow into the box below, marring the
appearance of the display. If a triple collision occurs on the bottom row of the display,
the title of the third holiday will be partially clipped by the window boundary.
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6. KNOWN PROBLEMS

6.1. Exceeding the Long Integer Limit

Instead of relying on crude validation limits on the entered year or Julian Day,
InterCal ought to check for the overflow, raise an exception, and issue a warning to the
user. Then only actual violations would prevent successful execution, and the user
would never see an unexpected year alert box when he has just entered a Julian Day.
Unfortunately, there appears to be no mechanism on the Macintosh (at least using C++)
to detect the overflow.

6.2. Improperly Displayed Popups

Sometimes popup menus in the displayed date controls will be truncated at the
right. Also, sometimes the popup menus (when activated) appear in 12-point type (the
program tries to display then in 24-point). These popup size problems appear to me to
be bugs in the Symantec Visual Architect code which initializes the popup menus. At
seemingly unpredictable times (but always during startup), it sizes them using the
system font instead of the actual font specified in my code. This bug has been reported
to Symantec. The problem usually goes away if you simply quit and restart the
program. An attempted work around for this problem was put into Version 1.2. It reduced the
frequency of occurrence of this problem, but did not completely eliminate it.

In OS 8 the month names in the expanded month pop up menu are not fully
visible (chopped off at the top and the right) even though there is plenty of room. I do
not know the cause of this problem, but it is probably due to some incompatibility
between my very old development environment and OS 8.

The mark character, which shows which popup item is currently selected, is not
properly displayed. This problem also appears to be either a bug or a feature of the
Visual Architect code. I know of no work around.


